
August 5, 1999 Meeting Announcement 
Lernout and Hauspie and Syntran 

 

Our August, 1999 DVPC meeting will feature Lernout and Hauspie, one of the leading publishers of voice 
recognition software. We’ll see Voice Xpress which comes in versions for all levels of users. Depending on 
the version, Voice Xpress features dictation into Microsoft Word, or almost any Windows applications. And 
it has been updated to work with Microsoft Office 2000. The demo will show how Voice Xpress achieves up 
to 98% accuracy, L&H XpressStart lets you begin using the package as soon as you install it, and Talking 
Tools. Then Syntran (who missed the July meeting) will demonstrate FaxPrint and CamPrint. FaxPrint 
bypasses your computer, directing incoming faxes straight to your printer so they can be printed 
immediately. With CamPrint you simply connect your digital camera and your printer to the CamPrint unit 
and you can print all or individual photos, multiple photos of the same image, or select different sizes to 
print — all without having to turn on your PC. And we’ll have a special DVPC auction, featuring two copies 
of Microsoft Office 2000 Premium. See the article on page 10 for more information about the auction 
DVPC meetings are held in the lobby conference room in Building B at the Bank of America Technology 
Center office complex in Concord, located near the northeast corner of Clayton Road at Galindo (see the 
Map to Monthly Meetings on page 15). Please use the main entrance of the building, which is in the center 
of the front of the building that faces Clayton road. 
Doors open at 6:30 p.m. and the main meeting starts at 7:00 p.m. From 6:30 to 7:00 we’ll have the New 
User's SIG meeting; you can visit the Networking Table if you have something to sell or trade, need 
technical help, or just want to exchange views; and, as usual, we'll have library disks and those great 
DVPC mugs (version 2) for sale. The main meeting will include SIG news, random access, our presenters, 
and some of our usual great door prizes. See you at this month’s meeting! 
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President’s Corner  
By Alan Mildwurm, DVPC 

e-DVPC! 
This month, in addition to two excellent presentations by 
Lernout and Hauspie  (voice recognition software) and 
Syntran (FaxPrint and CamPrint, held over from the July 
meeting), we will have a mini-auction of several products 
which we have acquired. Our showcase products to auc-
tion are two copies of Microsoft Office 2000. We have a 
diverse spectrum of goodies which I think will be of inter-
est to our members. As a DVPC first, you will be able to 
bid on the products prior to the meeting over our website! 
You MUST be present at the August meeting meeting to 
finalize your bid! Of course you will be able to pick up 
these terrific products at great prices, but we have estab-
lished some minimums – our treasurer won’t let us just 
give them away!! 

Help us augment the treasury while you add to your soft-
ware collection! See the “Rules Article” in this issue de-

(Continued on page 2) 
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President’s Corner... 

(Continued from page 1) 
 

scribing the products available, the minimum bids and the procedures we have established. And be sure to bring your 
wallet and/or checkbook to the August DVPC meeting and be ready to bid high and bid often!  

We think this will be a fun event! See you on August 5th. 

That stack of old issues of Diablo Blue that Alan Mildwurm handed me continues to provide material that re-
minds us that, when someone tells you about “the good old days of computers,” you should remind them that 
today is much better! And, so you know exactly what I mean, a reprint of one of those old articles follows for 
your interest and amusement. Look for more in future issues of Diablo Blue. 

More Blasts From the Past  by Ron Ogg, DVPC 

Our Archives: PC Desktop Publishing  by Doug Blackburn, DVPC 

From the August, 1986 Issue of Diablo Blue  
The PC does not have any really powerful full featured desktop publishing programs available yet, though fall promises 
to bring several contenders for top of the line. Current PC offerings all work, but none has a full complement of features. 
For simple newsletters, the low cost “Click Art Personal Publisher” might work just fine. Portions of “Click Art” were 
used in putting together the June Diablo Blue newsletter. “Click Art” can be purchased for about $110 (discount). The 
full bore programs are likely to be over $500 (even discounted). Sophisticated desktop publishing is VERY demanding 
of both programmer and hardware, so don’t expect it to be cheap. For a business though, the full featured programs will 
provide the capability to do things that were not previously affordable and/or do in-house publishing for a lot lower cost 
than was possible with pre-desktop publishing methods. 

The reality of desktop publishing is that it may turn out to be too much for present PC compatible hardware (including 
the AT). Present high end desktop publishing hardware is based on a high speed version of the Motorola 68000 proces-
sor installed in what is often called a ‘pedestal’. These machines usually have hard drives in the 70 megabyte (single 
user) to 150 megabyte (multi-user) range and run the full UNIX operating system that allows multiple work stations to 
be on-line simultaneously. In these systems, desktop publishing is 100% high res graphics with large, full page monitors. 
The memory demands and microprocessor demands are so high that even with additional microprocessor support de-
vices, the speed degradation of having three workstations on-line at one time becomes quite noticeable. 

The newest development in the hardware end of these desktop publishing systems is the addition of a PC compatibility 
board that allows the user to run PC software in a ‘window’ the size of the normal PC screen. Having these systems able 
to run PC software opens a whole new set of possibilities. In general, because of demand and numbers, PC based soft-
ware is among the most user friendly, feature oriented, and affordable. Having PC software available on these expensive 
machines will make them able to serve more than one purpose and will allow off line composition and work from PCs to 
be easily transferred to the ‘big’ system. 

Cost of the high end hardware continues to come down, but is still in the $20,000 to $48,000 price range for a single sta-
tion setup without a laser printer. That kind of money buys a lot of computer power, so you can imagine how difficult it 
will be to get acceptable performance on a PC. There is a good chance that a ‘hot rodded’ AT running at 11 or 12 mega-
hertz with a math co-processor would handle a single user with acceptable speed. But, if that configuration is still too 
slow, it will take the next generation of hardware based on the 80386 or 68020 to make truly functional full featured PC 
based desktop publishing possible. 

And you thought you were having problems with your current Windows 98 based desktop publishing package and your 
poor old slow PC with its Pentium, PII, PIII, or K6 processor! No more complaining, hear? [Ron Ogg] 
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At the June Board of Directors meeting it was decided to redesign the Diablo Blue masthead. The prior masthead was 
getting a bit, well, long in the tooth. Mark Allen, DVPC Publicity Director, has come up with some great designs for our 
new brochures, so I “borrowed” one of the pieces of clip art that Mark had chosen and that’s what you’ll see at the right 
side of the new masthead design. 

The font for the publication title Diablo Blue is new, also. The font we’ve been using is Broadway, cutting-edge 

when it was originally selected but now somewhat old fashioned. The new font is Comic Sans, which goes well with 
the style of the masthead graphic. 

The shaded (colored on the web) background below the masthead that had our user group name and the month of publi-
cation has been removed so it’s easier to read. 

We’ve also changed the font used for the page 1 meeting announcement from Arial, a sans serif typeface, to Trebuchet, 
which is a semi-serif face and is supposed to be easier to read in smaller point sizes like what we use in Diablo Blue. We 
can get more characters in the same space with Trebuchet than with Arial, so we can squeeze more description into the 
meeting announcements. Trebuchet is installed when you install Internet Explorer 5, or by installing the Additional Web 
Fonts from Windows 98’s Windows Update. 

We hope you like the new look. Let us know your opinion.  

A New Look for the Diablo Blue Masthead  by Ron Ogg, DVPC 

Free Clipart and Web Images from Corel  by Corel Software 

In celebration of the grand re-opening of ClipArtDownload.com (www.clipartdownload.com), Corel is offering 10,000 
clipart images and 100,000 web images for free! Simply click on New User and enter your name and e-mail address. 
You will then be emailed a password that will give you access to 110,000 of the best looking clipart and web images 
around. Keyword search features lets you find your images quickly & easily.  

James A. Garvey  by Peggy Johnson, DVPC 

James A. Garvey, a member of DVPC since 1992, died in his sleep on May 17, 1999.  He kept in touch with friends and 
family all over the world with his computer and had published 3 books of poetry, “Looking At Mars” (WWII memories), 
“Avid For The Sip” and “Bone Fire”. 

Printing Access Relationships  found on the Web by Ron Ogg, DVPC 

Relationships between Access tables are a bit easier to grasp if you can see a visual representation of those relationships. Fortunately, 
you can open the Relationships window by choosing Relationships from the Tools menu. Access displays the existing relationships 
between the tables you add to the window. You can also create and delete relationships here. Although this is useful, you can't just 
click the Print icon so you have a hard copy for later reference. Fortunately, there are two ways to print a graphical representation of 
these relationships. If you're using Access 97, you can use the Print Relationships wizard, available free from Microsoft. To 
download this add-in, visit http://officeupdate.microsoft.com/downloadDetails/prels80.htm. 

After installing the wizard, choose Add-Ins from the Tools menu and Print Relationships from the resulting submenu. The wizard 
creates a report that contains a representation of the existing relationships.  

If you're using Access 95 or version 2.0, you can't use the wizard. Instead, open the Relationships window and press Alt-Print 
Screen. Then open WordPad or another text editor and press Ctrl-V to paste a copy of the Relationships window into your text edi-
tor. At that point, all you have to do is print the document.  

Access 2000 now makes printing the relationships easier than ever. From the Relationships window, simply choose Print Relation-
ships from the File menu and print the resulting report. 
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SIG NEWS Compiled by Nick Chase, SIG Coordinator, DVPC, 680-4211 

See the DVPC Calendar on page 16 for the date and time of each SIG meeting. 

Access/Visual Basic SIG Ron Ogg (283-7900 Ext. 201) and Ted Armstrong (939-4096) SIG Co-Leaders 
The Access/Visual Basic SIG meets on the fourth Tuesday of each month at 7:30 p.m. at Gateway Group’s offices, 3687 
Mt. Diablo Blvd., Suite 350, in Lafayette. We‘re continuing to enhance the DVPC membership roster program to add a 
feature that will let us automatically generate the monthly meeting announcement email messages. Even though this is an 
Access program, we’ll be working in Visual Basic (VBA). If you are interested in Access or Visual Basic, be sure to join 
other programmers at this month’s Access/VB SIG meeting.  

Check out the Access/VB SIG on the web for information about each month’s meeting at www.dvpc.org/sig_vbaccess – 
or navigate there from the DVPC home page (www.dvpc.org), select SIGs from the menu bar at the left, then click on the 
Access/VB SIG icon. See the web page or the Clarion SIG announcement below for directions to the meeting.  

Advanced Users SIG Jeff Noyer and Sharon Clark , SIG Co-Leaders – 937-5282 
The Advanced Users SIG meets on the third Thursday of each month at 7:30 p.m. at 336 El Divisadero Avenue in Walnut 
Creek. Directions: From downtown Walnut Creek, take Ygnacio Valley Road toward John Muir Hospital. Continue past 
Walnut Boulevard and John Muir Hospital. At the intersection of Ygnacio Valley Road and Walnut Avenue, turn right 
onto Walnut Avenue. At the first traffic light, turn right onto Blackstone Drive, then make the first right onto El 
Divisadero Avenue. Follow the road as it curves to the left. 336 El Divisadero Avenue will be on your right, immediately 
after the curve. It is a one-story, gray/brown house with white trim. The Advanced Users SIG is for anyone interested in 
discussing advanced topics such as hardware and software issues, cutting-edge technologies, networking, Windows NT 
Server and Workstation, troubleshooting, etc. Please join us to participate in this very informative and educational forum. 
We hope to see you at the meeting! 

Clarion SIG Ron Ogg, SIG Leader – 283-7900 Ext. 201 
The Clarion SIG meets at 7:00 p.m. on the fourth Wednesday of each month at Gateway Group’s offices, 3687 Mt. 
Diablo Blvd., Suite 350, in Lafayette. Check out the Clarion SIG on the web for information about each month’s meeting 
at www.dvpc.org/sig_clar. TopSpeed’s Clarion 5 is a powerful object-oriented database development tool that competes 
with products like Visual Basic and Delphi and even products like PowerBuilder. If you are an advanced Clarion 
developer you are invited to join the SIG. This is a SIG for advanced users, so beginners will want to get some hands-on 
experience before joining. We’re continuing with coverage of the Clarion 5 Programmer’s Guide, so see the Clarion SIG 
web site to find out what chapter to read. Be sure to come early for a good seat; the meetings are very well-attended. 

Directions: take Highway 24 west to the Central Lafayette exit, and keep to your left to the stop sign at Deer Hill Road at 
the end of the exit ramp. Turn left onto Deer Hill Road, and continue to where it dead ends at Happy Valley Road. Turn 
left onto Happy Valley Road. Turn right at the traffic signal at Mt. Diablo Blvd. Take Mt. Diablo Blvd. through the next 
traffic signal and turn left into the driveway at 3685/3687. Immediately turn right into the parking lot in front of 3687. 
Take the elevator to the third floor to the door on the right just before the end of the hallway. See the Clarion SIG’s Web 
page for a map. If you get lost, call Ron Ogg at 283-7900 Ext. 215.  

Education and Entertainment SIG Alan Mildwurm , SIG Leader – 510-770-5770 
The Education & Entertainment SIG usually meets on the fourth Wednesday of each month at Montevideo School in San 
Ramon at 7:30 p.m. However, Montevideo School and the E&E SIG are closed for summer vacation. The 
E&E SIG is oriented to exploring the best in education and entertainment software for the PC. Everyone is invited to 
attend our meetings, and bring your kids along – they’ll have a great time, too! Directions: Take 680 to Bollinger Canyon 
Road, go west to San Ramon Valley Blvd., go south to Montevideo Rd. and turn left. Proceed east on Montevideo about 
3 blocks to Broadmoor and turn left The school is 1 block on the right. We meet in Room 22. 

(Continued on page 5) 
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(Continued from page 4) 

Internet SIG Craig Peterson, SIG Leader – 671-7025 
The Internet SIG meets at 7:00 p.m. on the third Wednesday of each month at Computer Renaissance, 959 Contra Costa 
Blvd. in Pleasant Hill. We cover everything about the Internet, from browsing and email to creating your own web site 
and the tools for doing so. For more information, please call Craig Peterson at 671-7025 or him an email message at 
compmail@pacbell.net. 

Microsoft Project SIG Elias Asmar, SIG Leader – 299-8500 
The Microsoft Project SIG meetings are held at 7:30 p.m. on the third Monday of each month at InterPro ADF’s office at 
3569 Mt. Diablo Blvd., Suite 210. Park in the lot behind Radio Shack. The entrance to suite 210 is at the back of the 
building. Enter through the door marked “210” at the parking lot end of the walkway from the street and take the stairs to 
the second floor. Everyone who is interested in Microsoft Project and project management is invited to attend. If you plan 
on attending, please call Elias Asmar at 925-299-8500, Fax 925-299-8511, or send an email message to him at: 
elie.asmar@iadf.com. 

New Users SIG Bill Earl, SIG Leader – 939-5874 
The New Users SIG holds its meetings at 6:30 p.m. prior to the regular DVPC monthly meeting on the first Thursday of 
each month at Bank of America building B. We discuss whatever is confusing or puzzling new PC users. If you are a new 
user of PCs who would like to meet with other new users – and some experienced users who can answer your questions as 
well – then join us at the New Users SIG meetings at 6:30 p.m. prior to each DVPC monthly meeting. 

Photo SIG Chuck Graham, SIG Leader – 680-1333 
The Photo SIG meets on the second Tuesday of the month at 7:00 p.m. Thanks to coordinator Jon McNally, Chief 
Photographer of the Contra Costa Times, the next DVPC Photo SIG meeting (Mac users also welcome) will be at the 
Contra Costa Times Newspapers, 2640 Shadelands Drive, Walnut Creek. We will gather at the security office (in the 
parking lot) at 7:00 p.m. on August 10th. Then we will take a tour and see how the newspaper is produced and how they 
send photos to one of America’s great dailies and what it takes to make it hit the street. 

New people are welcome at our meetings.  Please email your and full name and current email address to graham@value.
net for follow-up information and to be placed on the Photo SIG notification list Please let us know what programs or 
speakers you can provide for our monthly meetings. 

If you're interested in digital photography, scanning photographs, and more, check back for all the details about this 
interesting new SIG. You can also contact Chuck Graham, the Photo SIG leader, via email at graham@value.net for more 
information.  

Real Estate SIG Bill Thompson, SIG Leader – 693-0174 
The Real Estate SIG meets on the third Monday of each month. Because we’re still tying down the meeting location, you 
will have to check with Bill Thompson for the exact time, location, and directions. We have limited seating so you must 
RSVP for the meetings. Please contact SIG Leader Bill Thompson at 925-998-8530 or email him at 
thompson@DLSNetwork.com. 

Windows SIG Ron Ogg (283-7900 Ext. 201) and Walt Parsons (934-0775), SIG Co-Leaders 
The Windows SIG usually meets at the Community Room at the Concord Police Department Building on the fourth 
Friday of each month at 7:30 p.m. However, the Windows SIG will closed for summer vacation in July and 
August. Be sure to join us in September when our meetings resume. Everyone who uses, is interested in, or 
is curious about Windows on their PC, is invited to attend. See you all at the next Windows SIG meeting.  

(Continued on page 6) 

SIG NEWS... 
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Membership Drive! 
Bring a Friend! Bring a Co-Worker! Bring a Neighbor! Bring Several People! 

Get Them to Join DVPC! 
For Each Guest You Will Receive an Extra Raffle Ticket! 

“I am a real computer person and as such recognize the ultimate reality of the ‘Paperless Society ’. In keeping with this 
spirit and in an effort to help DVPC reduce overhead costs, I say “Nay” to a written newsletter. Give it to me 
electronically, I want to get my copy of DVPC’s Diablo Blue off the Web. (I can always print it out on blue paper and 
don’t even have to admit that I did!)” Turn in this form at the monthly meeting – or email to nopaper@dvpc.org 

 

Name: _________________________________________________________________________________________ 

 

Address: _______________________________________________________________________________________ 

 

City: __________________________________________________________________________________________ 

 

State: _______  Zip:  __________________________   Phone: ____________________________________________ 

 

Email address for meeting notification: ____________________________________  Also notify me about these SIGs: 
 

_______________________________________________________________________________________________ 

Switch to the Diablo Blue Web Edition 

(Continued from page 5) 
 

Here are directions: The Concord Police Department is at 1350 Galindo Street in Concord. From the 242 Freeway take 
Clayton Road east to Galindo and turn right; the Police Department building is 3 blocks south on your left. From 
Highway 24 take Monument Blvd. east and continue on Monument Blvd. to where it changes to Galindo; the Police 
Department building will be on your right a short distance past the signal at Cowell Road. 

New SIG? 
Are you interested in starting a new SIG? It’s easier than you probably think! To get started, just see our new SIG 
Coordinator Nick Chase at the monthly meeting, or send him at email asking about starting your new SIG at 
nachase@yahoo.com.  

There are lots of areas where you may find DVPC members with interests that are similar to yours. How about a 
database SIG? Or a genealogy SIG? You’ll never know until you give it a try. Ask Chuck Graham who started the 
popular Photo SIG, or Bill Thompson who started what’s probably the first Real Estate SIG in the country. It’s up to 
you! 

SIG NEWS... 
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We’re providing an Email Notification service for the DVPC  monthly meeting, and for SIGs as well, for all current, paid-up me m-
bers. If you’re interested in receiving an email message announcing each monthly meeting, and for the SIGs you attend, fill out this 
form and mail to the address on page 16 of this copy of Diablo Blue. Note that there’s no separate notification for the New Users SIG 
since it’s held on the same night as the monthly meeting. 
 
Send me Email notification of each monthly DVPC meeting: 
 
Name ____________________________________________________________________________________ 
 
Email Address ______________________________________________________________________________ 
 
Also send me Email notification of each of the SIG meetings I’ve checked below: 

Email Meeting Notification Available  by Ron Ogg, DVPC 

Access/VB SIG   Microsoft Project SIG  

Advanced Users SIG   Photo SIG  

Clarion SIG   Real Estate SIG  

Education and Entertainment SIG   Windows SIG  

Internet SIG     

DVPC Board Meeting Minutes  by Tom Krauss, DVPC 

Meeting Date: 7/7/99 Time : 7:00 p.m. Location: Alan Mildwurm’s house 
Bank Account : $700 (Approximately)  
Upcoming Speakers : 
August:       Lernout and Hauspie Speech Recognition Software, and Syntran Photo and Fax Printing Software, 
                    plus an auction including two copies of Microsoft Office 2000 Premium! 
September:  Enfish Personal Document Management Software 
 

News Flash: Corel was there, really, at the July meeting! And an amazing demo of Corel Draw was presented, too! 

Old Business: 
Projector:  Despite the presence of Charlie, we did not talk about this for the second month in a row. 

New Business: 
Publicity: Despite Mark’s absence, we discussed some aspects of publicity, although only briefly.  Still daring to be 
different, Peggy came up with another good idea: generic DVPC business cards that all members can hand out.  These 
would contain information such as our web site url, meeting location and schedule, etc.  They would  not contain the 
members name, only DVPC.  This was a difficult concept for some of us to grasp, and will probably have to be discussed 
again. 

Ron has been searching for someone to print our fliers, brochures, etc. for free, but as yet has had no success. Any 
members with connections are encouraged to speak with Ron or another Board member. 

Random Access:  Why is it that the meetings at which little business gets done run longer? Other topics discussed include, 
but are not limited to, various models of digital cameras; Nick’s misspent youth as one of those irritating phone solicitors; 
a brief history of computers (always a favorite with the Board); why our web page is slow to download (you get what you 

(Continued on page 9) 
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Get a Friend to Join Get a Friend to Join DVPC!DVPC!  
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Get Involved! Learn! 
Join a SIG today! 

DVPC Board Meeting Minutes... 

(Continued from page 7) 

pay for, and we get it free); landscaping; white sound; Stan’s new French press coffee maker; bandwidth (guaranteed to 
come up in any conversation with Charlie around); and how to run a successful auction.  

Video System:  Charlie suggested that since our treasury is low, we need to establish a fund for a new video projector.  
He apparently did not hear my suggestion that we sell the current one and put that money into the fund. 

Assigning Blame:  Even the Board was embarrassed at the paucity of work done at the end of our two hour meeting.  It 
was moved, seconded and passed unanimously to blame Mark for this, since he wasn’t present to deny responsibility. 

ThumbsPlus – A Software Review  by Alan Mildwurm, DVPC 

Lately, we have been using our CD-ROM burner to create “digital memory books” as Ruth calls them. She has been tak-
ing digital pictures of her class all year and wanted to burn a CD for each of her students. We also wanted to give a 
friend a CD of all the photos we had of him at different family events. In both cases, we used Kai’s Power Show to cre-
ate the slideshow. The ease of that product and the phenomenal transitions make that an excellent program to make a 
really professional looking slideshow. We keep all our digital pictures on a zip drive divided into separate subdirectories 
(junior prom, trip to Seattle, Thanksgiving dinner, etc). Since we create a new subdirectory for each batch of digital pic-
tures, the names of the files in each directory as they are downloaded from the camera are the same: 1.jpg, 2.jpg, 3.jpg… 
Therefore, I needed a program which would let me view all the pictures in a subdirectory, select the ones I want, copy 
them to a working directory, and rename them so as I copy picture 6 from one subdirectory to the working subdirectory 
it doesn’t overwrite picture 6 which I previously copied from another subdirectory into my working directory.  

ThumbsPlus let me do this very easily. This program is loaded with excellent features for managing and manipulating 
graphics files. Installation is very simple. The program can read several dozen file types including avi, Casio camera, 
Flashpix, Kodak, QuickTime, Macintosh Paint, Twain, Seattle Filmworks, Corel, NASA fits, ico, uue – about 100 by my 
count! Naturally, it supports all the “regular” file types: gif, bmp, jpg, tif, wav (yes sound files too!), and often several 
variants of each: jpg, jfi, jif, jpeg. 

The program is designed around thumbnails. It automatically will generate thumbnails for the recognized files in the 
folder you visit. You can scan entire disks for files. Thumbnails are organized in a tree format. You can set up the pro-
gram to maintain and show the thumbnails even if the CD (source) is not in the drive! 

In addition, you can adjust colors, use filters (sharpen, edge detection), rotate, resize, crop, apply (stamp) text or other 
images, cut and paste pieces and save your results in many formats. The program can also convert from metafile to raster 
images. You can also find images by similarity, find duplicates, print contact sheets, print catalogs, build web pages, dis-

(Continued on page 10) 

Support Diablo Blue Advertisers! 
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(Continued from page 9) 

play a slideshow, automatically make thumbnails of new files, capture screen shots, and copy, move and delete thumb-
nails. 

I love the copy process. When I was moving files around ThumbsPlus immediately recognized the name conflict (both 
pictures having the same name), showed me a thumbnail of each with file information (file size, date created, etc.) and 
asked me what I wanted to do. Since all the files were taken from the same camera, often the file size and sometimes 
even the date would be the same. Having the thumbnails let me determine if it was a duplicate image. If I wanted both, 
ThumbsPlus automatically renamed the file, thus preserving both pictures. I will demonstrate this program at an upcom-
ing meeting since this is one of my favorite utilities. 

Here’s what’s needed to run ThumbsPlus: 

Operating system: Win 95, 98, NT 4, 2000.  

Minimum system: Pentium 90, 16 MB memory, 20 MB HDD, video with 256 colors. Recommended system: Pentium 
166, 64 MB memory, 20 MB HDD, video with 32 bit true color. 

By the way, I used a 133 with 32 MB of memory and ThumbsPlus worked fine! 

If you use graphics files, get this! The download version is $75.00 from Cerious Software Inc., Charlotte N.C. Go to 
their web site at www.cerious.com. 

ThumbsPlus... 

August Auction   by Ron Ogg, DVPC 

No, we’re not auctioning off the month of August. But, at our August general meeting on the 5th, we are going to have a 
great auction. We have two copies of Microsoft Office 2000 Premium plus several other interesting packages, all brand 
new and in their original packages. 

Office 2000 Premium includes Word, Excel, PowerPoint, FrontPage, and Publisher. The street price for a complete copy 
is $699, and the upgrade street price is $449. Here’s your chance to get your own copy, and help DVPC by adding to our 
coffers. 

Here’s how to place your bid ahead of time: Go to the DVPC web site, www.dvpc.org, click on “August Auction” and 
fill out the form you’ll find there. The web bids will be compiled and posted at the August meeting, and an advance over 
the high web bid will be the starting point for the bidding at the meeting.  

Bring your checkbook to the August DVPC meeting and be prepared to bid high and bid often! You may just walk out 
with a copy of Microsoft Office 2000 Premium! 

Free Software Offer   by Justin Morgan, Software602 

Software602 would like to give you some FREE software! We are looking to get your feedback on this product, and in 
return we will give members of the Diablo Valley PC User’s Group a full working copy with a retail value of $49.95. 

602 Pro Personal OFFICE SERVER is your home communication center. It handles all message types including e-
mail, faxes, and voice mail for you; plus have these messages forwarded to you with "Follow Me" technology. Be in 
complete control of your own messaging needs and do it all from one product on your home computer. 

You can download your copy of 602 Pro Personal OFFICE SERVER at www.602pro.com/downloads/pos.html. 

Use Registration Code: POS-01099999-001-GST0.  

Your questions or comments on 602 Pro Personal OFFICE SERVER can be sent to support@software602.com. 
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Print Selected Material from Web Pages 
First, as in making Rabbit Stew, you must catch the rabbit! In this case, before you can print sections of text from Web 
pages you must first select the material, then paste it into an appropriate software program (e.g. WordPad, any word 
processor, MS Publisher, etc.). Do that by following these steps. (Selecting and Printing graphics is covered toward the 
end of this article). 

1. Select desired text material in the normal manner by setting your cursor at the upper left corner of the text and holding 
down the left mouse button. Continue holding the button down and drag the cursor to the end of the material you want to 
select, then release the button. Your selected text should now be highlighted.  

2. Go to the Edit Menu at the top of your screen and click on Copy (or use the Control-C keyboard shortcut). If you don't 
already have the target software application open, open it now via the Start Menu or a shortcut icon on your Desktop. 
(Let's assume you will use WordPad from the Accessories Group in the Start Menu. It's quick and easy, and everyone 
who uses Windows 95/98 has it available.)  

3. Go to the File Menu and click on New to open a new document. 

4. Make sure the blinking insertion pointer (vertical bar) is positioned at the upper left of the blank page. 

5. Go to the Edit Menu and click on Paste (or use the Control-V keyboard shortcut). The selected material should now 
appear on the blank page. 

6. Now you can either save the text (using Save As from the File Menu), edit it to reformat some of the text or to remove 
unwanted material, or print it (by going to the File Menu and selecting Print). 

I do this all the time. Frequently, when researching a subject for a future article, I first create a file by following steps 3 
and 4, typing in just a tit le and perhaps a few notes at the top of the page, then I use File/Save As to give the file a name 
and save it in an appropriate folder. I visit various Websites, select helpful material and use Copy/Paste (steps 1 through 
5) to insert it into the previous ly created file. 

I often use WordPad for this, but MS Word, Word Perfect or some other word processor that offers a Find or Find/
Replace function may be preferable if you assemble a large amount of text in a single file. Such software allows you to 
search for a word or phrase quickly and easily when necessary.  

The process for selecting and Printing material from e-mail is the same. Follow the same Copy, Paste, Print sequence 
outlined above. 

If you want to print an entire Web page, simply click on the right mouse button anywhere on the page. Select Print from 
the pup-up menu that appears and follow normal Printing procedure.  

If you want to print a picture or other graphic from the Web, do this: 

1. Place cursor on designed image. 

2. Click right mouse button.  
(Continued on page 12) 

Become a Mentor   by Alan Mildwurm, DVPC 

DVPC has a large number of knowledgeable members who are intermediate to expert users of various software 
packages. We’re going to resurrect our Mentor program and take advantage of this storehouse of knowledge 
and let members share their knowledge with other members. If you use particular software packages, and 
would like to help other members when they have questions about any of those packages, you are a candidate 
for becoming a Mentor. Check the web site and look for a Mentor Information Form at the May meeting, and 
help your fellow DVPC members 

Ken’s Korner  by Ken Fermoyle 
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KRISHNA COPY CENTER 
State-of-the-Art Electronic Printing  

DESKTOP PUBLISHING Ž COPYING Ž PRINTING 
1676 No. California Blvd., Plaza #119 

Walnut Creek, CA 94596 

(925) 256-6898 
10% Discount for DVPC Members with this Ad! 

Ken’s Korner... 

(Continued from page 11) 

3. Click on Save Picture As 

4. Select the drive and folder where you want to store the graphic. 

5. Save it under the original name, or give it a new name. 

You can then print the graphic by importing it into an appropriate image editing program (e.g. Windows Paint, Photo 
Deluxe, Photo Shop, Photo Impact, etc.). Reminder: Web images are normally in low-resolution GIF of JPEG formats so 
they will not look as good when Printed as BMP, TIFF or other higher resolution images. 

A tip here: If you're only interested in printing out the text on a page, just turn off the graphics. In Internet Explorer fol-
low these stops. 

1. On the View menu in the browser, click Internet Options.  

2. Click the Advanced tab.  

3. Select the Multimedia tab, and remove checks in the Show pictures, Play animations, Play videos, and Play sounds 
check boxes. 

This will make Web pages load a lot faster, too. You can always turn the pictures, animations, etc. back on by reversing 
the procedure.  

Actually, what I do is use two browsers an older version of Netscape Navigator with graphics turn off, and a current ver-
sion of Internet Explorer with all the goodies turned on. I use Navigator for research and other quick-and-dirty surfing, 
IE for normal Web wandering when I want to see all the graphics. 

Copyright 1999 by Ken Fermoyle, kfermoyle@earthlink.net. 

Special Offer on Income Tax Software  by Cammie Greif, 2nd Story Software, Inc. 

Many User Group members learned about 2nd Story Software’s TaxACT '98 last year.  TaxACT is the low cost, easy to 
use tax preparation software for individuals.  Not only did we hear from User Group Members, we also had positive re-
views from major computer magazines, including PC Computing, Computer Shopper, Business Week, Home Office 
Computing and Family PC. 

TaxACT is developed by a team of tax accountants and programmers. With their experience on your side, TaxACT sorts 
through the new tax law changes! Never again worry about doing your taxes, let TaxACT do it for you! You can file 
your taxes with your computer – print your return to file or file electronically!  

We understand the time and effort it takes to sift through the many software products available and we want to say 
"Thanks!"  To express our thanks, we are offering a special price on our TaxACT '99 Deluxe and TaxACT '99 State  prod-
ucts to all DVPC User Group members. Every member is entitled to receive TaxACT '99 Deluxe and State for only 
$19.00 via download. 

DVPC members can find the special offer at www.taxact.com/products/ebird.asp?sc=1210330. 
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ACROSS 
  2 Computer aided instruction 
  5 Computer aided design and drafting 
  9 Teleprinter with keyboard 
 10 Interactive programming language for time sharing on large mainframes  
 14 Office automation 
 15 Number based on 16 digits  
 18 Language used in business applications  
 22 Language developed in USSR 
 23 Computer aided design 
 25 1/250,000,000 of an inch 
 26 Transfer data into a computer device 
 29 Random access memory 
 31 Hewlett-Packard 
 33 Compiler language for solving mathematical problems 
 34 Standard typewriter keyboard for the English language 
 38 Language that includes logical gates "and", "or", and "not" 
 39 Printer that uses special paper and heat 
 41 Computer aided manufacturing 
 

DOWN 
  1 Artificial intelligence 
  3 Command for both inputs to be present for output 
  4 Optical character recognition  

  6 Language invented by Wayne Ratcliff 
  7 Local area network 
  8 Picture element 
  9 1024 bytes of information 
 11 Central telephone switching machine 
 12 Punched card code 
 13 Garbage in garbage out 
 16 Escape key  
 17 Assembly Language Code 
 19 Operating system 
 20 Compiler language named after A. Byron, Countess of Lovelace 
 21 International Business Machines Corporation 
 22 Type of display  
 24 Nanosecond 
 27 Series of data in a row or matrix 
 28 An ordered collection of data 
 30 Language used for scientific and mathematical problems 
 32 Language named after the person who designed and built the first calculator 
 35 Boot function of a computer 
 36 Command that the output is opposite the input 
 37 Command for either input to be present for output 
 38 Extra machine readable copy of data 
 40 Hertz  
 

See the solution at the August DVPC meeting. 
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Diablo Blue Article and Ad Information 
Diablo Blue needs articles from the members of DVPC. See your name in print! Achieve fame and fortune!  (Well, maybe just some 
limited fame in Contra Costa County...)  We are particularly interested in product and book reviews and articles about your PC 
experiences. 
Commercial advertising is available in Diablo Blue. Prices are $75 for a full page, $40 for a half page, and $25 for a quarter page for 
one insertion – or get three consecutive insertions for the price of two. For more information, call editor Ronald Ogg, at 283-7900, 
Ext. 201 (days). Members of DVPC can submit personal classified ads that will be printed in Diablo Blue for three insertions at no 
charge. The rules are simple: up to 9 lines (as we typeset it), material must be suitable for publication (the editor is the sole judge of 
suitability), the member must be in good standing (current dues paid), and ad space is available on a first-come first-served space 
available basis only. If you want fewer than three insertions note that on your ad copy. If members want their business card 
reproduced, the rate is $10 for one insertion, or $25 for three insertions. The card must be horizontal and must  be scannable. 
Send your articles or member ad copy as email attachments to the Newsletter Editor, or mail to: Editor, Diablo Blue, P.O. Box 2222, 
Orinda, CA 94563-2222. See the deadline information in the Calendar on page 15 of each issue of Diablo Blue.  

DVPC on the Internet  
DVPC has a web site on the Internet – thanks to our Web Team: Ron Ogg and Stan Umlauft. You can surf your way to our own 
domain and home page by starting your favorite Web browser and typing the following URL; be sure to save it in your browser’s 
hotlist so you don’t have to type it each time:  

http://www.dvpc.org 

DVPC Officers and Directors 
Alan Mildwurm, President/Programs  770-5770 (work)      Mark Allen, Publicity  680-7746 (home) 
Nicholas Chase, SIG Coordinator  680-4211 (home)      Charlie Crothers, At Large  829-2237 (home) 
Bill Earl, Sergeant-at-Arms  939-5874 (home)      Peggy Johnson, Membership Secretary  676-7522 (home) 
Tom Krauss, Secretary  689-9960 (home)      Jessica Mildwurm, Treasurer  829-5858 (home)       
Ron Ogg, Newsletter Editor  283-7900 Ext. 201 (work)      Craig Peterson, Librarian  671-7025 (home)      
Stan Umlauft, Web Site  458-5560 (home) 
 
The Board of Directors usually meets on the Wednesday evening following the general meeting each month. Check the DVPC  
Calendar on page 16 of each issue of Diablo Blue, or the DVPC home  page on the Internet (www.dvpc.org) for the meeting date, time, 
and location. You can reach any of the officers and directors by talking to them at the DVPC monthly meeting, or leaving a message 
on the DVPC voicemail System.  

DVPC Voice Mail System 
DVPC  has a computer-based voice mail system. The phone number for the DVPC  VMS is 556-1449. This communication vehicle 
provides members with up-to-date information about monthly and SIG meetings, potential new members with information about 
DVPC, and a message center for Board of Directors members and SIG Leaders. 
 

Diablo Blue is the monthly newsletter of the Diablo Valley PC Users’ Group. Editor: Ronald Ogg, Mailing: Peggy Johnson 
Please submit articles and columns to the Newsletter editor by email at rogg@value.net or mail them to: 

Ronald Ogg, P.O. Box 2222, Orinda, CA 94563-2222 
Entire contents © 1998-1999 by Diablo Valley PC Users' Group. All commercial rights reserved. 

The Diablo Valley PC Users' Group is a non-profit corporation.   

  DVPC is a member of APCUG, the Association of PC Users Groups   
 

DVPC is a member of UGNN, the User Group Network News Service    

Support DVPC – Get a friend to join! 
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MEMBERSHIP APPLICATION 
Enclose a check for $30.00 for one year’s dues with printed edition of Diablo Blue or $25.00 for one year’s dues with access to the 

Internet edition of Diablo Blue ($20.00 for students who must enclose a copy of current Student ID) made payable to DVPC and mail 
to:  

DVPC User’s Group, PO Box 667, Danville, CA 94526 
 

Renewal_____          New Member_____      Referred by current member? Name___________________________ 
 

 Name:  __________________________________________________________________________________ 
 
 Company/School: _____________________________________  Email address: _______________________ 
 
 Address:  ________________________________________________________________________________ 
 
 City/State/Zip: ___________________________________________________________________________ 
 
 Home Phone: _______________________ Work Phone:     ________________________________________ 
 

 
 Email Address: ___________________________________________________________________________ 
 

On occasion DVPC publishes a list of members for distribution to DVPC  members only.  Please check how you would like to be 
listed:  No listing_____     List Name and Home_____  Work_____   phone number(s)  

 
I’m also interested in these SIGs: ______________________________________________________________ 

Directions to 
Bank of America 

Building B 
in Concord 

Take the Clayton Road exit off of 
the 242 Freeway, and go east on 

Clayton Road. 
After about 1½ miles you’ll come to 
Galindo, and you’ll see the Bank of 
America complex of four high-rise 

office buildings. 
Building B is the first building on 
your left, at the northeast corner of 

Clayton and Galindo. 
Parking:  Turn right on Grant Street 
(the first block past Galindo), then 
right into the BART parking lot at 
the back of the BofA complex. Or 
turn left on Galindo then right onto 

Concord Avenue to find street 
parking.  

Be sure to observe parking 
regulations! Concord parking 

officers are very efficient! 

CLAYTON

C O N C O R D

W I L L O W  P A S S

PARKING

B A N K  O F  A M E R I C A
TECHNOLOGY CENTER

2001 CLAYTON RD.
C O N C O R D ,  C A

BUILD ING B
N

6 8 0
2 4

2 4 2

S E E  M A P
A B O V E

680/24

6 8 0

2 4

C O N C O R D

W A L N U T
CREEK

LAFAYETTE

BERKELEY

O A K L A N D

CALDECOTT
TUNNEL

ORINDA

DANVILLE



DVPC August 1999 Calendar 

 
Diablo Valley PC User’s Group 
PO Box 3244 
San Ramon, CA 94583 
 
 
 
                                                                                                                             FIRST CLASS MAIL 

 TO: 

MON TUE WED THU FRI 

2 3 4 5 6 
   DVPC Monthly Meeting 

7:00 p.m. 
New User's SIG  
6:30 p.m. 

 

9 10 11 12 13 
 Photo SIG 

7:00 p.m. 
Board Meeting 
7:00 p.m. 
Alan Mildwurm's house 

 Diablo Blue deadline Email articles 
and ads to the Newsletter Editor: 
rogg@value.net 

16 17 18 19 20 
Microsoft Project SIG 
7:30 p.m. 
Real Estate SIG  
9:00 a.m. 

 Internet SIG 
7:00 p.m. 

Advanced Users SIG  
7:30 p.m. 

 

23 24 25 26 27 
 Access/Visual Basic SIG 7:30 p.m. Education & Entertainment SIG: 

On Summer Vacation 
Clarion SIG 7:30 p.m. 

 Windows SIG  
On summer vacation… see you in 
September 

30 31    

    See SIG News starting on page 4 for 
more information about SIG meeting 
dates, times, topics, and locations 


